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1. Insert your heading here (do not copy paste)

(10 pt) The paragraphs continue from here and are only separated by headings, subheadings, images
and formulae. The section headings are arranged by numbers, bold and 10 pt. Here are further
instructions for authors.

1.1 Structure

Files should be in MS Word format only and should be formatted for direct printing. Figures and tables
should be embedded and not supplied separately. Please make sure that you use as much as possible
normal fonts in your documents. Special fonts, such as fonts used in the Far East (Japanese, Chinese,
Korean, etc.) may cause problems during processing. To avoid unnecessary errors you are strongly
advised to use the ‘spellchecker’ function of MS Word. Follow this order when typing manuscripts: Title,
Authors, Affiliations, Abstract, Keywords, Main text (including figures and tables), Acknowledgements,

I Corresponding author. E-mail address: donottypehere@email.com (Please do not type or edit anything here, our editors will
do the work for you)
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References, Appendix. Collate acknowledgements in a separate section at the end of the article and do not
include them on the title page, as a footnote to the title or otherwise.

Bulleted lists may be included and should look like this:

e First point
e Second point
e Andsoon

Ensure that you return to the ‘Main Text’ style, the style that you will mainly be using for large blocks
of text, when you have completed your bulleted list.

Please do not alter the formatting and style layouts which have been set up in this template document.
As indicated in the template, papers should be prepared in single column format. Do not number pages on
the front, as page numbers will be added separately for the preprints and the Proceedings. Leave a line
clear between paragraphs. All the required style templates are provided in this document with the
appropriate name supplied. Please refer to page 7 for complete guide on styles.

1.2 Tables

All tables should be numbered with Arabic numerals. Headings should be placed above tables, left
justified. Leave one line space between the heading and the table. Only horizontal lines should be used
within a table, to distinguish the column headings from the body of the table, and immediately above and
below the table. Tables must be embedded into the text and not supplied separately. Below is an example
which authors may find useful.

Table 1. An example of a table (Font = 8; Click ‘Caption A’ on the Styles Gallery)

An example of a column heading Column A (¢) Column B (7)
And an entry 1 2
And another entry 3 4
And another entry 5 6

1.3 Construction of references

References should be listed at the end of the paper, should be arranged first alphabetically and then
further sorted chronologically if necessary. More than one reference from the same author(s) in the same
year must be identified by the letters “a”, “b”, “c”, etc., placed after the year of publication.

Some examples of how your references should be listed are given at the end of this template in the
‘References’ section which will allow you to assemble your reference list according to the correct format
and font size.

1.4 Section headings

Section headings should be left justified, with the first letter capitalized and numbered consecutively,
starting with the Introduction. Sub-section headings should be in capital and lower-case italic letters,
numbered 1.1, 1.2, etc, and left justified, with second and subsequent lines indented. You may need to
insert a page break to keep a heading with its text.

1.5 General guidelines for the preparation of your text
Avoid hyphenation at the end of a line. Symbols denoting vectors and matrices should be indicated in

bold type. Scalar variable names should normally be expressed using italics. Weights and measures
should be expressed in SI units. Please title your files in this order firstauthorname.docx.
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1.6 Footnotes

Footnotes should be avoided if possible. Necessary footnotes should be denoted in the text by
consecutive superscript letters. The footnotes should be typed single spaced, and in smaller type size
(8pt), at the foot of the page in which they are mentioned, and separated from the main text by a short line
extending at the foot of the column. The ‘footnote’ style is available in this template for the text of the
footnote.

1.7 Referencing and citation style

The manuscript’s references and citations should be written using the APA 7™ edition style. In terms of
the in-text citation style, APA uses the author's last name and the year of publication, for example: (Field,
2005); (Field & Thomas; 2014). If there are three or more authors, cite only the surname of the first
author followed by “et al.” and the year., for example: (Field et al., 2017). For direct quotations, include
the page number as well, for example: (Field, 2005, p. 14).

The sample of references is available on page 5. Please refer to the following website for further
details on APA 7" edition referencing style: https:/libraryguides.vu.edu.au/apa-referencing

2. Author artwork

All figures should be numbered with Arabic numerals (1,2,...n). All photographs, schemas, graphs and
diagrams are to be referred to as figures. Line drawings should be good quality scans or true electronic
output. Low-quality scans are not acceptable. Figures must be both embedded into the text and all images
should met the minimum requirement of 500 x 500 pixels. Lettering and symbols should be clearly
defined either in the caption or in a legend provided as part of the figure. Figures should be placed at the
top or bottom of a page wherever possible, as close as possible to the first reference to them in the paper.

2.1 Diagrams

Diagrams can be in the form of framework, process flow, chart, or any visual aids that are meant to
support the written text. Any diagrams built using Microsoft Word or Powerpoint’s Smart Art Graphic
Tool needs to be embedded as editable or vector-based objects (instead of image objects). Diagrams
attached using bitmap-based images (jpeg., png., and other formats) need to be in high resolution (at least
300 pixels per inch).

2.1.1 Texts embedded in diagrams

The font used for labels or indicators inside the diagram needs to be formatted as Times New Roman
with font size set at 9. It must not be bold, italized or underlined.
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Figure 2. (left) this framework is a non-editable diagram, appears blurry and hence, is unacceptable;
(right) this framework is built using Ms Word illustration tools, has higher resolution and is acceptable.
(Font =9; Click ‘Caption B’ on the Styles Gallery)

Please use the ‘drawing canvas tool’ in Ms Word before inserting any images or diagrams into the
document. When constructing a conceptual/theoretical framework, please use editable or vector-based
diagrams. Draw diagrams using Ms Word’s Smart Art Graphic Tool (textboxes, labels, arrows, legends,
etc.) rather than embedding non-editable image objects. Ensure that all the figures have a good resolution
(minimum 300dpi) and are not fuzzy or blurry.

2.2 Captions

The figure number and caption should be typed below the illustration in 9pt and left justified. Artwork
has no text along the side of it in the main body of the text. However, if two images fit next to each other,
these may be placed next to each other to save space, see Fig 1. They must be numbered consecutively, all
figures, and all tables respectively.
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3. Equations and formulas

Equations and formulae should be typed and numbered consecutively with Arabic numerals in
parentheses on the right hand side of the page (if referred to explicitly in the text). They should also be
separated from the surrounding text by one space. If you chose to use the Equation Editor, please ensure
that the manuscript is saved using .docx format (rather than .doc), and Compatibility Mode is turned off.

Rt=KEP =93.02 (+9.62) - 13.45 (1)
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An example appendix

Authors including an appendix section should do so after References section. Multiple appendices
should all have headings in the style used above. They will automatically be ordered A, B, C etc.

A. Example of a heading within an appendix
Al Example of a sub-heading within an appendix

There is also the option to include a subheading within the Appendix if you wish.
About the Authors (this section is compulsory)

Please submit another separate file by naming it as “Author Information”. Avoid revealing the identity
and information of the authors in the manuscript (that should be anonymous). Provide the following
information in the separated file.

Author 1 (Full Name, without Titles/Designation), Please summarize the academic background and details
of the author, and contact information (an e-mail address is compulsory for the corresponding author).
Please also include your 12-digit Orcid ID (visit http://orcid.org to register). The authors’ biographical
information will be displayed after the Reference List. Maximum number of words is 100.

Author 2 (Full Name, without Titles/Designation), Please summarize the academic background and details
of the author, and contact information (an e-mail address is compulsory for the corresponding author).
Please also include your 12-digit Orcid ID (visit http://orcid.org to register). The authors’ biographical
information will be displayed after the Reference List. Maximum number of words is 100.

EXAMPLE:

Danial Rashid, PhD is Associate Professor in the Department of Management and Finance at the
University of Malaysia (ORCID: http://orcid.org/0000-0000-0000-0000). His main research activity is in
the area of organizational innovation and organizational learning. He has published widely on these
subjects in publications such as the International Journal of HRM, Journal of Business Research,
International Journal of Information Management and Management Decision. His can be reached
through his email at danialrashid@university.edu.

Authors’ contributions (this section is compulsory)

This section is compulsory. Please submit this information in another separate file by naming it as
“Author Information”. Each author contribution must be stated clearly reflecting each contribution to the
body of the work and manuscript. There are fourteen types of author contributions. Some of these
contributions (if not all) need to be specified and attributed to each of the author(s).

e Conceptualization
Data collection
Formal Analysis
Funding acquisition
Investigation
Methodology
Project administration
Resources
Software
e  Supervision
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Validation

Visualization

Writing — original draft
Writing — review & editing

For example:

Jaya Subramaniam carried out the research, wrote and revised the article. Rahmah Hassan
conceptualised the central research idea and provided the theoretical framework. Both Rahmah Hassan
and Chong Ju Lian designed the research, and supervised research progress. Rahmah Hassan anchored the
review, revisions and approved the article submission.

a ® 124 by the authors. Submitted for possible open access publication under the terms and
conditions of the Creative Commons  Attribution (CC BY) license
(http://creativecommons.org/licenses/by/4.0/).

Note: Please include the above copyright disclaimer and logo in your manuscript.
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Style Formatting: Special Instruction to Authors (Please read this)

e Authors are required to edit the template using Microsoft Word 2010 onwards.
e  Authors must use the ‘Styles Gallery’ to format the written contents of the article.
e The Styles Gallery is located within the Home Ribbon, in the Styles Pane.

Home tab Applied Style Text Style Gallery
(ol 9 ¢ s Document] - Mirosoft Word )
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DLV s wwa e awkAaBlenc A 8
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v
On the Insert tab, the galleries
include items that are designed «

coordinate with the overall look of your document. You can use these galleries to insert

tables. headers, footers, lists, cover pages. and other document building blocks: When you
create pictures, charts, or diagrams, they also coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a
look for the selected text from the Quick Styles gallery on the Home tab. You can also format
text directly by using the other controls on the Home tab. Most controls offer a choice of

using the look from the current theme or using a format that you specify directly.

To chanze the overall lock of vour document. choose new Theme elements on the Page

MG 3. s (-

The Styles Gallery’ appears as follows:

Please utilize the Styles Gallery when formatting your article.

Please avoid doing the following:
o adjust the paragraph parameters
o add numbering to headings
o increase or decrease indentation
o create new headings

If the

formatting appears to stray away from the requirements, select the affected

paragraphs/headings, and click the “Clear Formatting” icon at the ‘Font’ section of the ‘Home’

ribbon.
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The formatting will be reset. Again, apply the intended formatting by clicking the specific style

using the Styles Gallery.
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Please refer to the table below to understand the target use of each of the specific style.

Style Name Targeted Use
Title Main title
Author Authors’ names

*corresponding author s details are located at the
footnote section of the first page

Affiliation Author’s institutional affiliation

Footnote Corresponding author’s e-mail address (use institutional
g;én)ail address instead of free e-mail such as gmail, yahoo

Heading A Main header with numbering (1,2,3...)

Heading B Second level header (e.g. 1.1, 1.2, ...)

Heading C Third level header (e.g. 2.2.1,2.2.2, ...)

Main Text The write-up of the article

Caption A Caption for Table

Caption B Caption for Figure

Reference Bibliographic reference with indentation

zAppendix Heading 1 Appendix header with lettering (A. B, C ...)

zAppendix Heading 2 Appendix second-level header with alphanumeric coding

(e.g. B1.B2,B3...)
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e If you successfully adhere to this instruction, your article will be generated into a bookmarked
PDF that is easy to be navigated by readers.

E X |[#f] JEEIR2018_636_Khan x
E ¥ 1. introduction
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||j 2.1 Capitalism

Available online 3t www_jeeir.com
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1] 2.2 Mixed economy M\EEIR Economies and
ISSN: 2269.2559 .
[A] 2.4 Banking implications Joumnal of Famerging Feomamies & ldamic Ressarch 60 2015, 50 os_191AMIC Research
—

||j 2.3 Islamic banking

principles
] 5. Objectives of the research Islamic banking opportunities in a non-Islamic economy:
[ <. Literature review Customer perspectlves OfNCW Zealand
A 5. Methodology and data .
Source Rubaiyet H. Khan®', Geetha Subramaniam®, Ershad Ali¢, Saida Parvin®
B |IJ 6. Findings “Curtin University, Perth, Australia
1] . "Universiti Teknologi MARA Selangor, Malaysia
L :t:W D:redor of Amanah “Auckland Institute of Studies, Auckland, New Zealand
ical
[N 6.2 Non Muslim customer ARTICLE INFO ABSTRACT
who uses traditional banking -
Article history: New Zealand as a representative of a non-Islamic economy holds some
m 6.3 Muslim custormer who Received 12 June 2018 unique characteristics. It is small enough to test a new banking concept
uses traditional banking 53";"“_”16“&‘*‘1 form without many risks at the same time the results can be replicated
A August 2078 effectively in larger economies like Australia, Canada, UK and USA. The
customer cepted 10 § ber 2018 N &
Accept cptember 2012 current study uses four exploratory interviews and a robust literature
Published 30 September 2018 - P - )
m 6.4 Bank manager - review to propose frameworks for future studies in this area of
{traditional banking system) J[‘-_l]:\""'_"ﬁ;;' N knowledge. The results suggest opportunities of a market that can be a
) Trmfitioml bank source of effective knowledge For successful market entries for Islamic
[ 7. Discussion and Analysis “’.:!t’é‘r""::mor:v banks around the world. Finding of this study may be of interest of future
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I[l 8. Conclusion e featan future markets of Islamic banks.
E 1. Introducti
- ntroduction
]
Political and economic philosophy of a country is reflected in its banking structure (Berg, 2016). Thus,

e This journal is a double-blind peer-reviewed open access journal that does not charge any
publication fees. The journal is managed by volunteering academics of UiTM whose
responsibilities include teaching, research, supervision, administration, and other academic
obligations. Hence, your adherence to this guideline when submitting your manuscript is highly
appreciated.
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